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Menu Commands

To get information about one of the Mail menus, click the menu or press TAB to select the menu, then press ENTER.
If custom commands or forms have been installed on your Mail system, there may be 
additional commands on the Mail menus.



Quick Help instructions
The information in this topic is here to help you quickly find what you need in Mail's online 
Help. For more information about Help, choose How to Use Help from the Help menu.

To select one of the topics in the Table of Contents, click it or press TAB to select the 
topic you want and then press ENTER.
F1 To get information about a dialog box, form, or a selected command, press F1.

    The pointer becomes a hand when it is over a region that contains more information (a 
pop-up topic) or a jump to another topic. Click the mouse in this region to jump to the topic 
or view the pop-up topic.

    To get back to the last topic you were looking at, click the Back button, or press B.
    Choose the Overview button to display general information about a procedure.
    Choose the Index button to display an alphabetical list of all the information in the 

online Help file. You can view any of the entries in the Index by choosing them.
 This indicates a jump to another topic. To display the topic, choose the text.

 This indicates there is a pop-up topic containing a definition or further information about 
this text. To clear a pop-up topic, click anywhere outside the popup or press ESC.

    To view all the Help topics available in the Contents, choose the Expand button.
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File Menu
The File menu provides commands for working with your messages and folders.

Click the command you want information about, or press TAB until the command is highlighted, and then press 
ENTER.



File Menu Commands

Open
Use the Open command to open a selected folder, message, or attachment.

If nothing is selected, this command is unavailable.
See Also

Opening and Saving an Attachment
Reading a Message



File Menu Commands

Move
Use the Move command to move a selected message or folder.

The Inbox, Outbox, Sent Mail, and Deleted Mail folders cannot be moved or deleted.
You can create a new folder when you move a selected message or folder.
You can also move folders and messages by dragging them to another folder, or to 

the Inbox, Outbox, or Deleted Mail folder. Folders moved to the Deleted Mail folder are 
deleted.

If nothing is selected, this command is unavailable.
Move Message Dialog Box Options
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.

Move Folder Dialog Box Options
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.

See Also
Moving a Folder Within a Folder
Moving Messages Between Folders



Move To
Choose the folder that you want to move the selected folder or message to.



Type
This box displays the type of folder you have selected. You can move a message, but not a 
folder, between shared and private folders.



OK    Choose OK to move the selected message or folder into the folder you have selected.
Cancel    Choose Cancel to close the dialog box without moving the selected message or 
folder.
New    Choose New to create a new folder. After you have created the new folder, it is 
highlighted in the Move To box.
Help    Choose Help to display the Help topic describing the options in this dialog box.



File Menu Commands

Copy
Use the Copy command to put a copy of the selected message or folder in another folder.

When you copy a folder, all folder contents are copied, including subfolders.
You can create a new folder that the selected message or folder will be copied to.
Use the Copy command on the Edit menu to copy selected text to the Clipboard.
If nothing is selected, this command is unavailable.

Copy Message Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

Copy Folder Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

See Also
Moving a Folder Within a Folder
Moving Messages Between Folders



Copy To
Choose the folder that you want to put the copy in.



Type
This box displays the type of folder you have selected. You can copy a message, but not a 
folder, between shared and private folders.



OK    Choose OK to put a copy of the selected message or folder in the folder you have 
selected.
Cancel    Choose Cancel to close the dialog box without copying the selected message or 
folder.
New    Choose New to create a new folder. After you have created the new folder, it will 
appear highlighted in the Copy To box.
Help    Choose Help to display the topic describing the options in this dialog box.



File Menu Commands

Delete
Use the Delete command to delete a selected message or folder.

Deleted messages are moved to the Deleted Mail folder. Messages deleted from the 
Deleted Mail folder are permanently deleted.

When you delete a folder, all its messages and subfolders are deleted.
If nothing is selected or the selection cannot be deleted, this command is 

unavailable.
Note    Use the Delete command on the Edit menu for deleting text.

See Also
Deleting or Retrieving a Message
Deleting a Folder
Copying, Moving, or Deleting Information Within a Message



File Menu Commands

Save As
Use the Save As command to save a selected message or a message that is open in a Read
Note form.

Message text is saved as a text file with a .TXT extension as the default; you can 
assign it any extension. The default file name is the first eight letters of the message 
subject.

You can save multiple messages in a single text file by selecting the messages and 
saving them under a single name with this command. To select multiple messages, hold 
down CTRL while clicking the messages you want to select, or hold the CTRL key down, 
highlight the messages using the arrow keys, and select the messages using the SPACEBAR.

If you choose to save the file with an existing file name, you can either append the 
message text to the existing file or replace it.
Save Message Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

See Also
Opening and Saving an Attachment
Saving a Message as a Text File



File Name
This box displays the default filename for a message, which is the first eight characters of 
the Subject line in the message header, followed by a .TXT extension. You can type a 
different filename, or select an existing filename from the list. If you choose an existing file, 
you can either append the new message text to the existing file, or replace the existing text
with the new message text.



List Files of Type
The selected message(s) are saved as a text file.



Directories
Choose the directory where you want to save the message text. To open a directory, 
double-click it, or press TAB to move the highlight to the Directories box. Use the arrow keys 
to select the directory, and then press ENTER.



Drives
Choose the drive where you want to save the message text.

To choose a different drive, click the down arrow and double-click the drive you want, 
or press TAB to move the highlight to the Drives box. Then press ALT+DOWN ARROW to display 
the available drives, and use the arrow keys to select a drive.



OK    Choose OK to save the message text in the name and location specified.
Cancel    Choose Cancel to close this dialog box without saving the message text.
Help    Choose Help to display the Help topic describing the options in this dialog box.



File Menu Commands

Save Attachment
Use the Save Attachment command to save a file that is attached to a message.

This command is available if there is an attached file in the selected or open 
message.

Attached files appear in your message as an icon of the application that created the 
file, or with a default document icon if the application is not available.
Save Attachment Dialog Box Options
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.

See Also
Opening and Saving an Attachment



Attached Files
This box lists all the files that are attached to the message. Select the file you want to save,
or choose the Save All button to save all the attached files.



File Name
This box displays the filename of the selected attachment. You can save the attached file 
with this name or type a new name.
All the files in the current directory are displayed below the File Name box. If you attempt to
save the attached file with the name of a file that already exists, Mail asks if you want to 
overwrite the existing file.



Directories
The first line shows the path of the current directory. This line changes to reflect any 
changes you make in the Directories box.
The Directories box displays the directory tree.

To open a directory, double-click it, or press TAB to move the highlight to the 
Directories box. Then use the arrow keys to select the directory, and press ENTER. The files in 
the open directory are displayed in the File Name box.



Drives
This box shows all the drives your computer is connected to.

To choose a different drive, click the down scroll arrow and double-click the drive you 
want, or press TAB to move the highlight to the Drives box. Then press ALT+DOWN ARROW to 
display the available drives, and use the arrow keys to choose a drive.



Save    Choose Save to save the selected attachment in the location specified.
Save All    Choose Save All to save all the files attached to the open message in the 
location specified.
Close    Choose Close to close this dialog box. You must choose the Save button to save an 
attachment. The Close button only closes the dialog box.
Help    Choose Help to display the Help topic describing the options in this dialog box.



File Menu Commands

Message Finder
Use the Message Finder command to search for a particular message or messages and 
display them in a separate Message Finder window.

You can find messages from a particular person, about a particular subject, to various
recipients, or with specific message text. You can also search for any combination of these 
options.

Choose the Where To Look button to specify the folders you want to search. If you 
choose the Look In All Folders option, the Deleted Mail folder is not searched.

If you often search for a particular type of message, minimize the Message Finder and
keep it on the Mail workspace. For example, to keep a list of all the messages you have from 
Eric, create a Message finder with Eric in the From box. The list is automatically updated 
when you receive a message from Eric. You can keep several message finders for different 
categories of messages.

Message Finder windows are continuously updated, even when they are minimized on
the Mail workspace.
Message Finder Window Options
Click the window region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

See Also
Finding a Message



From
Type the name of the message sender. To find messages from more than one sender, 
separate the names with semicolons (;).



Subject
Type the message subject you want to find. To find more than one subject, separate them 
with semicolons (;).



Recipients
Type the name of the message recipient. To find more than one recipient, separate their 
names with semicolons (;).



Message Text
Type the message text you want to find. To find more than one string of text, separate them
with semicolons (;).



Where To Look
Choose this button to select the folders you want to search. You can search all your folders, 
or a single folder selected in the list. If you select a folder with subfolders, the subfolders 
are also searched.



Start
Choose the Start button to begin the search for the messages with the search criteria you 
have entered in this dialog box.
Messages that meet the criteria are displayed in the Message Finder window.



Stop
Choose the Stop button to end the search. If you are searching a large number of 
messages, you can stop the search when the message you are looking for is displayed by 
choosing the Stop button.
Messages that meet the criteria are displayed in the Message Finder window.



Found Messages
Messages that meet the Message Finder criteria are listed in this box. To open one of the 
messages, double-click it, or highlight the message using the arrow keys and then press 
ENTER.



File Menu Commands

New Folder
Use the New Folder command to create a new mail folder. Folders can be either private or 
shared.

Private folders can be accessed only by you and are for your use only.
Shared folders can be accessed by others. You can specify other users' access 

privileges to shared folders that you create.
To create a subfolder or specify the folder level, choose the Options button.
If a folder is selected in the folder list when you create a new folder, the new folder is 

created as a subfolder of the selected folder.
New Folder Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

New Folder Options Dialog Box
To display this dialog box, choose the Options button.

See Also
Creating a Folder or Subfolder



Name
Type the name of the folder you want to create. The folder name is displayed in the folders 
list in the folder window.
Folder names can be made up of several words, up to 128 characters for private folders, 26 
characters for shared folders.



Comment
Type a comment to remind yourself or others what the folder contains. Comments are 
optional.



Other Users Can
This box provides options for shared folders only. You have full access to any shared folders 
you create.
Read    Other users can only read messages in the shared folder you are creating.
Write    Other users can save, move, or copy messages into the shared folder you are 
creating.
Delete    Other users can delete the shared folder you are creating.



Type
This box provides options for choosing the type of folder you are creating.
Private    Select this option to create a folder that only you have access to.
Shared    Select this option to create a folder that other Mail users can access. If you want 
to provide group access to a message, you can save it in a shared folder.



OK    Choose OK to create the folder with the properties you have assigned. You must type a
name for the folder to choose this button.
Cancel    Choose Cancel to close the dialog box without creating a new folder.
Options    Choose Options to view more folder options. This button is not available in the 
expanded version of this dialog box.
Help    Choose Help to display the Help topic describing the options available in this dialog 
box.



Level
Top Level Folder    Select this option to create a folder at the top level. Top-level folders 
are always visible in the folders list, while subfolders may be hidden inside other folders.
Subfolder Of    Select this option to make the new folder a subfolder of the selected folder.



File Menu Commands

Folder Properties
Use the Folder Properties command to check or change a folder's name, level, shared folder
privileges, or comment.
Folder Properties Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

See Also
Creating a Folder or Subfolder
Moving a Folder Within a Folder



Name
This box displays the name of the selected folder. You can change the name of the folder by
typing a new name.



Type
This box displays the type of folder that is selected. Private folders are stored on your 
computer. Only you have access to them. Shared folders are stored in your postoffice, and 
others using your postoffice can have access to them.



Level
This box displays the current location of the selected folder.
You can move a private folder to a new location by selecting the new location.



Other Users Can
This box displays the access privileges for the selected folder.
You can change the access privileges for a shared folder only if you created that folder.



Comment
This box displays the folder comment. Type a comment to remind yourself or others what 
the folder contains. Comments are optional.



OK    Choose OK to confirm or change the folder properties.
Cancel    Choose Cancel to close this dialog box without changing any of the selected 
folder's properties.
Help    Choose Help to display the Help topic describing the options in this dialog box.



File Menu Commands

Print
Use the Print command to print a selected message or messages.

Messages are printed as text in the system font.
To select multiple messages, hold down the CTRL key while clicking the messages.
To select a printer and its options, choose the Print Setup button.

Print Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

See Also
Printing a Message



Printer
This line displays the printer that is currently selected. To print on another printer, choose 
the Setup button.



Print Quality
This box displays the selected print quality. To change the print quality, click the down 
arrow and select the print quality from the list. Lower print quality generally prints faster.



OK    Choose OK to print the selected message with the options displayed.
Cancel    Choose Cancel to close this dialog box without printing the selected message.
Setup    Choose Setup to change printers or other printing options.
Help    Choose Help to display the Help topic describing the options in this dialog box.



Print Multiple Notes On A Page
Select this option to print as many messages as will fit on a page. If this option is not 
selected, each message is printed on its own page or series of pages.



File Menu Commands

Print Setup
Use the Print Setup command to select a printer and set its options.
Print Setup Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted, and then press 
ENTER.

See Also
Printing a Message
Print command



Printer
Select either the default printer that you have set up in Windows, or another printer. To see 
the available printers, click the down arrow in the Specific Printer box, or press ALT+P and 
then ALT+DOWN ARROW.



Orientation
Select either portrait or landscape orientation for printing messages. Portrait is the default 
orientation; landscape prints along the long page axis.



Paper
Size
Choose the paper size you want to print messages on.
Source
Choose the paper source you want to print from.



OK    Choose OK to accept the displayed printer setup.
Cancel    Choose Cancel to close the Print Setup dialog box without changing the printer 
setup.
Options    You may have more printer options depending on the printer you have selected. 
If so, this button is available and displays a dialog box with the appropriate options for the 
printer you have chosen.
Help    Choose Help to display the Help topic describing the options in this dialog box.



File Menu Commands

Exit
Use the Exit command to quit Mail.

Messages in the Deleted Mail folder are deleted, by default, when you quit Mail. If you
turn off this option, you must delete messages in the Deleted Mail folder manually. Choose 
the Options command on the Mail menu to change this option.

Mail prompts you to save any modified Send Note forms that are open. If you have 
messages in the Outbox, Mail asks if you want to send them before quitting Mail.

If you have other applications that use the postoffice running, this command does not
sign you out of Mail. Other applications can continue to use the postoffice.You don't need to 
enter your password to restart Mail.



File Menu Commands

Exit and Sign Out
Use the Exit And Sign Out command to quit Mail and close all applications that use the 
postoffice.

Use this command to prevent unauthorized access to your mail when you are going 
to be away from your computer for an extended period of time.



Edit Menu
The Edit menu provides commands for working with message text and objects.

Click the command you want information about, or press TAB to select the command and then press ENTER.



Edit Menu Commands

Undo
Use the Undo command to reverse the last editing action. You must use the Undo command
immediately following the action you want to undo.

If the action cannot be undone, the Undo command is unavailable.
You can also press CTRL+Z to undo an action.



Edit Menu Commands

Cut
Use the Cut command to remove selected text from a message and move it to the 
Clipboard.

The text you cut remains on the Clipboard until you cut or copy something else.
You can also press CTRL+X to cut selected text and move it to the Clipboard.
If no text is selected, the Cut command is unavailable.
To delete selected text, press DEL.

See Also
Copying Information Between Messages
Copying, Moving, or Deleting Information Within a Message



Edit Menu Commands

Copy
Use the Copy command to copy the selected text or object to the Clipboard. Once text or 
objects are copied to the Clipboard, you can paste them into another location.

The text you copy remains on the Clipboard until you cut or copy something else.
You can also press CTRL+C to copy selected text to the Clipboard.
The Copy command is unavailable if nothing is selected in a message.

See Also
Copying, Moving, or Deleting Information Within a Message
Copying Information Between Messages



Edit Menu Commands

Paste
Use the Paste command to insert the contents of the Clipboard into a message at the 
insertion point.

You can also press CTRL+V to paste the contents of the Clipboard.
The Paste command is unavailable if the Clipboard is empty or if the information in 

the Clipboard is of an unknown format and cannot be pasted into the message.
See Also

Copying, Moving, or Deleting Information Within a Message
Copying Information Between Messages
Copying Information from a File



Edit Menu Commands

Paste Special
Use the Paste Special command to paste an object from the Clipboard into a message.

An object retains the formatting and other characteristics it had in the application 
that created it. For example, you can copy part of a Microsoft Excel spreadsheet and paste it 
as an object into a message. The message recipient can double-click the object to open it in 
Excel and edit or print the object.
Paste Special Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Embedding an Object in a Message
Working with an Embedded Object



Source
This line displays the application used to create the object and the file the object came 
from, if that information is available.



Data Type
Select the type of object you want to paste. If the application used to create the object 
supports object linking and embedding (OLE), the application type should be listed.



Paste    Choose Paste to insert the object from the Clipboard into the message at the 
insertion point.
Cancel    Choose Cancel to close this dialog box without pasting the object.
Help    Choose Help to display the Help topic describing the options in this dialog box.



Edit Menu Commands

Delete
Use the Delete command to remove selected text. Deleted text is not saved on the 
Clipboard.

If you delete text by accident, immediately choose the Undo command to restore it.
Use this command to delete text in a message; use the Delete button on the tool bar 

to delete messages or folders.
You can also press DEL to remove selected text.

See Also
Deleting a Folder
Deleting or Retrieving a Message
Copying, Moving, or Deleting Information Within a Message



Edit Menu Commands

Select All
Use the Select All command to select the entire contents of a message, or the entire To, Cc,
or Subject box. You can also use the Select All command to select all the messages in a 
message list.

To cut or copy the entire contents of a message, use the Select All command to select
the entire message.
See Also

Copying Information Between Messages



Edit Menu Commands

Insert Object
Use the Insert Object command to create an object and/or insert an object in a message.

The Insert Object command displays a list of the object types that are supported on 
your computer. From this list, you can choose the application you want to use to create the 
object.

When you close the application after creating the object, the application may ask if 
you want to update your message. Choose the OK button to insert the object into the 
message.
Insert Object Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Embedding an Object in a Message
Working with an Embedded Object
Paste Special command



Object Type
This box lists the object types supported on your computer.
To create an object of a certain type, double-click the application name, or use the arrow 
keys to highlight the application and choose the OK button.



OK    Choose OK to open the selected application.
Cancel    Choose Cancel to close this dialog box without opening an application.
Help    Choose Help to display the Help topic describing the options in this dialog box.



Edit Menu Commands

Object
Use the Object command to open, activate, or modify the selected embedded object. To do 
this, you must have access to the type of application that created it.

The Object command opens the object in the application that was used to create it.
Use this command to activate objects that may include sound or animation, or to 

open an attached file.
See Also

Embedding an Object in a Message
Working with an Embedded Object



Edit Menu Commands

Insert From File
Use the Insert From File command to insert the text from a file into a message.

This command inserts ASCII text only. Other document formats may be illegible.
Insert From File Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Copying Information from a File



File Name
Type the name of the file you want to insert, or select a file from the list. If the file is not a 
text file, the inserted text may be illegible.



List File As Type
You can insert any type of document into a message; the file is converted to ASCII text.



Directories
Choose the directory you want to insert the text file from. To open a directory, click it, or 
press TAB until the highlight is in the Directories box. Use the arrow keys to select the 
directory, and then press ENTER.



Drives
Choose the drive where the file is located. To view the available drives, click the down 
arrow, or press TAB until the Drives box is highlighted. Then press ALT+DOWN ARROW.



OK    Choose OK to insert the selected text into the message.
Cancel    Choose Cancel to close this dialog box without inserting the selected text.
Help    Choose Help to view the Help topic describing the options in this dialog box.



View Menu
The View menu provides commands for changing the way you view messages and folders.
If a Read Note or Send Note form is displayed, the View menu has the commands listed on 
the right.
Click the command you want information about, or press TAB to select the command and then press ENTER.

    



View Menu Commands

Shared Folders
Use the Shared Folders command to display the shared folders in your postoffice.

You may not have access to all shared folders. The person who creates the folder 
assigns access privileges for that folder.

Another way to display the Shared Folders list is to click the Private Folders button 
above the folders list.

This command is available only when the Private Folders list is displayed.
See Also

Creating a Folder or Subfolder
Expanding and Collapsing Folders



View Menu Commands

Private Folders
Use the Private Folders command to display your Private Folders list.

Private folders are stored with your message file; only you can view or alter them.
The button above the folder list toggles the display between shared and private 

folders.
This command is available only when the Shared Folders list is displayed.

See Also
Creating a Folder or Subfolder
Expanding and Collapsing Folders



View Menu Commands

New Messages
Use the New Messages command to check for new messages in the Inbox or Shared Folders
list.

You can use this command to check your postoffice for new messages.



View Menu Commands

Sort By Sender
Use the Sort By Sender command to arrange your messages according to who sent them.

Sender names are arranged in alphabetical order. To reverse the order, hold down the
CTRL key and click the From button above the message list.

You can also sort messages by sender by clicking the From button, located above the 
message list.



View Menu Commands

Sort By Subject
Use the Sort By Subject command to arrange your messages according to the message 
subject.

Subjects are arranged in alphabetical order. To reverse the order, hold down the CTRL 
key and click the Subject button above the message list.

You can also sort messages by subject by clicking the Subject button above the 
message list.



View Menu Commands

Sort By Date
Use the Sort By Date command to arrange your messages according to the date the 
message was received.

The dates are arranged with the latest message at the bottom of the list. To reverse 
the order, hold down the CTRL key and click the Received button above the message list.

You can also sort messages by date by clicking the Received button above the 
message list.



View Menu Commands

Sort By Priority
Use the Sort By Priority command to arrange your message list with the highest priority 
messages at the top.

High-priority messages are marked with an exclamation point. Low-priority messages 
are marked with a down arrow. To reverse the order, hold down the CTRL key and from the 
View menu, choose Sort by Priority.



View Menu Commands

Split
Use the Split command to activate the split bar between the folders list and the message 
list. Move the split bar right or left to provide more space for the folders list or the message 
list.

To move the split bar, you can either drag it or use the arrow keys and then press 
ENTER.

You can also move the split bar with the mouse by clicking it and dragging it to the 
position you want. You can also resize the From, Subject, and Received columns this way.



View Menu Commands

Status Bar
Use the Status Bar command to show or hide the status bar at the bottom of the Mail 
window.

The status bar displays information about menu commands, the number of read and 
unread messages in the open folder, the time, and the current status of Mail.

When the status bar is displayed, this command is checked on the menu.



View Menu Commands

Tool Bar
Use the Tool Bar command to show or hide the tool bar.

The tool bar contains buttons for Mail's most frequently used commands.
Use the Delete button on the tool bar to delete messages or folders; use the Delete 

command on the Edit menu to delete selected text in a message.
When the tool bar is displayed, this command is checked on the menu.



View Menu Commands

Previous
Use the Previous command to display the previous message in the message list.

See Also
Reading a Message



View Menu Commands

Next
Use the Next command to display the next message in the message list.

See Also
Reading a Message



View Menu Commands

Open Inbox
Use the Open Inbox command to display the Inbox messages in the current message viewer
window.

You can also open the Inbox by double-clicking Inbox in the folder list.
See Also

Expanding and Collapsing Folders



View Menu Commands

Change Font
Use the Change Font command to toggle the display font of the message between the 
normal font and a fixed-pitch font. The default normal font is Helv 10-point, and the default 
fixed-pitch font is Courier 10-point.

Messages that are composed with a fixed-pitch font are sometimes easier to read 
when they are displayed with a fixed-pitch font, especially if the message contains tables.



Mail Menu
The Mail menu provides commands for working with messages and setting up Mail.

Click the command you want information about, or press TAB to select the command and then press ENTER.



Mail Menu Commands

Compose Note
Use the Compose Note command to display a Send Note form for composing a new 
message.

You can also display a new Send Note form by clicking the Compose button on the 
tool bar, or by pressing CTRL+N.

To move the insertion point in the Send Note form, press TAB.
Send Note Form Options
Click the region you want information about, or press TAB until the region is highlighted and then press ENTER.

See Also
Sending a Message



Mail Menu Commands

Reply
Use the Reply command to open a Send Note form addressed to the sender of the selected 
or open message.

When you choose Reply, the form is opened with the sender's name in the To box, the
subject of the message in the Subject box, and the message text in the message area.

You can type comments in the original message text when composing your reply.
Attachments and linked or embedded objects are not copied to the reply message.

See Also
Replying to a Message



Mail Menu Commands

Reply To All
Use the Reply To All command to open a Send Note form addressed to the sender and all 
recipients of the selected or open message.

When you choose Reply To All, the form is opened with the original sender's and 
recipients' names in the To box and all the Cc recipients in the Cc box. The subject of the 
original message is entered in the Subject box, and the original message text is entered in 
the message body.

You can type comments in the original message text when composing your reply.
When you choose this command, your name is automatically cut from the To and Cc 

lists.
See Also

Replying to a Message



Mail Menu Commands

Forward
Use the Forward command to send a copy of a selected or open message.

When you choose Forward, a Send Note form is opened containing the subject and 
message.

You can type additional comments in the message body.
Any attachments and linked or embedded objects are copied into the forwarded 

message.
See Also

Forwarding a Message



Mail Menu Commands

Address Book
Use the Address Book command to open the Address Book.

Use the Address Book to find user names, add or delete names in your Personal 
Address Book, get details about a user, or browse another user directory.

If a Send Note form is open, the Address Book is displayed with To and Cc boxes that 
you can use to address the message.
Address Book Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

If the Address Book is opened while a Send Note form is displayed, it contains To and Cc 
sections to help you address the message.
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Creating or Modifying a Personal Group
Getting Details About a User
Updating Your Personal Address Book
Using Mail's Address List



Personal Address Book directory
The name of the user directory is displayed above the list box. To change user directories, 
choose the Directory button. To open your Personal Address Book, choose the Personal 
Address Book button.

 Directory button
 Personal Address Book button



Directory button
 Directory button

Choose this button or press CTRL+L to choose either your Personal Address Book or your 
postoffice list.



Personal Address Book button
 Personal Address Book button

Choose this button or press CTRL+P to display the names and groups in your Personal Address
Book.



Find button

 Find button
Choose this button or press CTRL+F to find a name or the first part of a name in the current 
user directory.



Name Finder Dialog Box
Type the name, or first part of a name, you want to search for in the directory list. For 
example, you can search for all names that begin with the letters "rob." The name finder 
displays Robert Maxwell as well as Maria Robbins.
Find button    Choose Find to search the current directory.
Cancel button    Choose Cancel to close this dialog box without performing a search.



New Address button

 New Address button
Choose this button to add a new name and address to your Personal Address Book.



Add Names button

 Add Names button
Choose this button to add names selected in the directory list to your Personal Address 
Book.



Details button
Choose this button to get information about the selected name.



Remove button
Choose this button to remove the name selected in the Group Members box from the 
personal group.



Names list
This is a list of the names in the current directory. You can select a name by clicking it or by 
typing the first part of the name.
Group aliases are indicated by bold type. To find out the users included in a group alias, 
choose the Details button.



Close    Choose Close to close the Address Book.
Help    Choose Help to display the Help topic describing the options in the Address Book.



To    Choose To to add the selected name to the To list box. Names added to the To box are 
inserted in the To box in the Send Note form.
Cc    Choose Cc to add the selected name to the Cc list box. Names added to the Cc box are 
inserted in the Cc box in the Send Note form.



OK    Choose OK to accept the choices made in the Address Book and close it.
Cancel    Choose Cancel to close the Address Book without adding any names to the Send 
Note form.
Help    Choose Help to display the Help topic that describes the options in the Address 
Book.



Mail Menu Commands

Personal Groups
Use the Personal Groups command to create or change a group.

Creating a personal group makes it easy to address messages to a group of people 
you send mail to often.
Personal Groups Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Creating or Modifying a Personal Group



New    Choose New to create a new personal group and add names to it.
Edit    Choose Edit to change the selected personal group.
Remove    Choose Remove to delete the selected personal group.
Close    Choose Close to accept the changes and close this dialog box.



Personal group list
This box lists your personal groups.



Mail Menu Commands

Options
Use the Options command to set options for:

Saving a copy of outgoing messages in the Sent Mail folder.
Putting all the names of users you send messages to in your Personal Address Book.
Setting how often Mail checks the postoffice for new mail.
Choosing the type of message alarm you want.
Deleting the messages in the Deleted Mail folder when you quit Mail.

Options Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Setting Mail Options
Setting Message Options



Save Copy Of Outgoing Messages In Sent Mail Folder
Select this option if you want to save a copy of each message you send in the Sent Mail 
folder.



Add Recipients To Personal Address Book
Select this option to add recipients of all your messages to your Personal Address Book.



Check Spelling Of Messages Before Sending
This option is not available with this version of Mail.



Check For New Mail Every _ Minutes
You can set how often Mail checks your postoffice for new mail. The setting range is 1 to 
9999 minutes.



When New Mail Arrives
Sound Chime Select this option to sound a chime whenever you receive a new message.
Flash Envelope Select this option to flash an envelope on the cursor whenever you 
receive a new message.
You can select both of these options.



Empty Deleted Mail Folder When Exiting
Select this option to delete messages in the Deleted Mail folder when you quit Mail.
If you don't select this option, deleted messages accumulate in the Deleted Mail folder until
you delete them.



OK    Choose OK to accept the selected options and close this dialog box.
Cancel    Choose Cancel to close this dialog box without changing any of the options.
Server    Choose Server to change th eserver options. The Server button may or may not 
be available depending on the Mail driver you are using.
Help    Choose Help to display the Help topic that describes the options in this dialog box.



Mail Menu Commands

Change Password
Use the Change Password command to change your password.
Change Password Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Changing Your Password



Old Password
Type your current password in this box.
New Password
Type your new password in this box.
Verify New Password
Type your new password again to verify you have typed it correctly. The OK button is 
unavailable until you verify your password.



OK    Choose OK to accept the new password and close this dialog box.
Cancel    Choose Cancel to close this dialog box without changing your password.



Mail Menu Commands

Backup
Use the Backup command to create a copy of your message file (.MMF extension).

A backup file is a copy of your message file without your password stored in it.
If you have created a backup file, you can use it to restore your message file if there 

is a problem with the computer that holds your current message file.
When you open a backup file, you are asked if you want to make the backup file your 

primary message file. To use the backup file as your message file, you must convert it.
If you don't convert the backup file when you open it, you can read, delete, and move

messages, but you cannot compose or send new messages.
Backup Dialog Box Options
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Backing Up and Restoring Your Message File



File Name
Type a name for your backup message file. The file is saved with the message file format 
(.MMF extension).



List Files Of Type
The backup message file should be saved with the .MMF format. This is the default setting.



Directories
Choose the directory in which you want to save the backup message file. To open a 
directory, double-click it, or press TAB until the Directories box is highlighted. Use the arrow 
keys to select the directory, and then press ENTER.



Drives
Choose the drive in which you want to save the backup message file. To view all the 
available drives, click the down arrow or press TAB until the Drives box is highlighted. Then 
press ALT+DOWN ARROW.



OK    Choose the OK button to save the backup message file with the specified name and 
location.
Cancel    Choose the Cancel button to close this dialog box without saving a backup 
message file.
Help    Choose the Help button to display the Help topic describing the options in this dialog
box.



Window Menu
The Window menu provides commands for displaying and arranging Mail windows.

Click the command you want to information about, or press TAB to select the command and then press ENTER.



Window Menu Commands

New Window
Use the New Window command to display a new Mail folder window.

You can display the contents of two or more folders at once by opening new windows,
each containing a separate folder.

You can reduce a window to an icon by clicking the minimize button in the upper-right
corner of the window.



Window Menu Commands

Tile
Use the Tile command to arrange all open Mail windows so they appear side by side.

You can use this command to find a window that may be hidden under other 
windows.



Window Menu Commands

Cascade
Use the Cascade command to stack all open Mail windows so that the window titles are 
visible. If you have many windows open, they may be arranged with one stack on top of 
another.

You can use this command to find a window that may be hidden under other 
windows.



Window Menu Commands

Arrange Icons
Use the Arrange Icons command to organize the window icons across the bottom of the Mail
workspace.

You can use this command to find icons that may be out of view in the Mail window.
To reduce a Mail window to an icon, click the minimize button in the upper-right 

corner of the window.
You can move a folder or message by dragging it to an icon.



Window Menu Commands

Open Mail Windows
The list at the bottom of the Window menu displays the Mail windows you have open or 
minimized in the Mail workspace.

To view one of the windows in the list, click it, or type the number of the window.
The window that is currently displayed in the Mail workspace has a check mark next 

to it on the Window menu.
If you have more than nine windows open, the More Windows command is displayed 

at the bottom of the list. Choose this command to display a list of all the open windows.



Window Menu Commands

More Windows
Use the More Windows command to display a list of all open Mail windows. This command is
available only if you have more than nine Mail windows open.

To display one of the windows in the list, double-click its name. Or select the name 
using the arrow keys and then press ENTER.



Help Menu
The Help menu provides commands for accessing Mail's online documentation.

Click the command you want information about, or press TAB to select the command and then press ENTER.



Help Menu Commands

Contents
Use the Contents command to display the Help Table of Contents for Mail.

The Contents screen displays the categories of Help available. To see all the 
procedure topics, click the Expand button.

For more information about Windows Help, choose How to Use Help from the Help 
menu in the Help window.



Help Menu Commands

Index
Use the Index command to display the Help Index for Mail.

The Help Index displays an alphabetical list of all the Help topics and online 
information available.

The Help Index is displayed in its own window. The topics you choose from the Index 
are either displayed in the main Help window or in a pop-up topic.

You can minimize, size, or move the Help Index like any other window.



Help Menu Commands

About Mail
Use the About command to display Mail's version and copyright information.

The About screen also displays information about the configuration of your computer.



New Folder Options dialog box
This dialog box displays the options for new folders.
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Moving a Folder Within a Folder



Where To Look dialog box
You can search all your folders for the messages that meet the search criteria in the 
Message Finder, or if you know which folder a message is in, you can search only that 
folder.
Dialog Box Options
Look in all folders    Select this option to search all folders for messages with the search 

criteria specified in the Message Finder.
Look in    To search only one folder, select the folder from the list.
OK    Choose OK to close this dialog box and search the specified folders.
Cancel    Choose Cancel to close this dialog box without searching the specified folders.
Help    Choose Help to get information about the options in this dialog box.

See Also
Finding a Message



Message viewer window
The message viewer window shows the folders list on the left side of the window. The 
message headers in the open folder are displayed on the right side of the window. The 
Inbox, Outbox, Sent Mail, and Deleted Mail folders are message viewer windows that you 
can minimize but not delete.
The Outbox folder window does not have a folders list.
Click the window region you want information about, or press TAB until the region is highlighted and then press 
ENTER.



Folders list
The folders list displays either your private folders or the shared folders on your postoffice. 
To change the view from private to shared, click the Private Folders button at the top of the 
folders list.
A plus sign (+) indicates that a folder has subfolders. To view the subfolders, click the plus 
sign, or highlight the folder using the arrow keys and then type the plus sign key.
A minus sign (-) indicates that subfolders are displayed. To hide the subfolders, click the 
minus sign, or highlight the folder using the arrow keys and then press the minus sign key.
To show or hide all folders, press CTRL+PLUS SIGN or CTRL+MINUS SIGN,respectively.



From list
This list shows who messages are from and the current status of each message.
List of message icons

Unopened message
Open message
Unsent message
Message with attached file
High-priority message
Low-priority message

To display the messages in alphabetical order, click the From button at the top of the list. To
reverse the order, press CTRL and click the From button.
You can quickly select a block of messages by clicking the left side of the message list and 
dragging the selection.



Subject list
This list shows the subject line of each message. You can change the size of the subject list 
by moving the mouse pointer over the line on either side of the Subject button and 
dragging the button margin.
To view the messages in alphabetical order by their subject, click the Subject button. To 
reverse the order, press CTRL and click the Subject button.



Received list
This list shows the date and time each message was received.
To view the messages in chronological order, click the Received button. To reverse the 
order, press CTRL and click the Received button.



Send Command And Send Note Form
Use the Send command to open a Mail Send Note form with the active document 
automatically attached to the message.

You can use this command to address and send a message without starting Mail. You 
can attach other files to the message and choose message options as you would in Mail.

If you are not signed in to Mail, the Sign in dialog is displayed and you must sign in 
before the message can be sent.
Click the form region you want information about, or press TAB until the region is highlighted and then press 
ENTER.



Send button
Choose the Send button to send the message to the recipients in the To and Cc boxes.



Check Names button
Choose the Check Names button to compare names in the To and Cc boxes with names in 
your postoffice.

A name is underlined if it matches a name in your postoffice.
You can type a partial name and have it completed by choosing the Check Names 

button.
Once a name is underlined, you can delete but not edit the name.



Attach button
Choose the Attach button to attach a file or files to the message you are composing.

When you attach a file to a message, you send a copy of the file with that message. 
The original file is not changed.

The attached file is displayed in the message as an icon with the name of the file.



Options button
Choose the Options button to:

Request a return receipt. When the recipient opens the message, you are sent a 
receipt.

Save all messages you send in the Sent Mail folder.
Assign a priority to a message. A high-priority message appears in the recipient's 

message list with an exclamation point, and a low-priority message appears with a down 
arrow. The default is normal.



Address button
Choose the Address button to display the Address Book. You can use the Address Book to 
search for names in your postoffice or your Personal Address Book. Names chosen from the 
Address Book are inserted in the To or Cc box of the Send Note form.



To box
Type the name(s) of the message recipients in this box.

If you type more than one name, separate the names with semicolons, or by pressing
ENTER.

You can double-click underlined names in the To box to display user details.



Cc box
Type the names of the people you want to receive a courtesy copy of the message.

If you type more than one name, separate the names with semicolons, or by pressing
ENTER.



Subject box
Type the message subject in this box. The subject is displayed in the message list.



Message area
Type the message text in this area.

To move the insertion point to this area, click the message area, or press TAB until the 
insertion point is in the message area.

Inserted objects and icons for attached files are displayed in the message area.



Read Note form
The Read Note form displays the message header information and the message text.

You can reply to or forward the message by clicking the Reply, Reply All, or Forward 
button.

You can see user address information by double-clicking any name in the message 
header.

You can edit the message text in the Read Note form, and in the Subject line, but not 
the rest of the message header.
See Also

Reading a Message



File Exists dialog box
There is already a file with this name in this location. You can save the file in another 
location, or you can choose one of the buttons available in this dialog box.
Append to    Choose Append to to add this file to the end of an existing file with the same 
name.
Overwrite    Choose Overwrite to replace the existing file with this file. The existing file is 
deleted.
Cancel    Choose Cancel to close this dialog box without saving the file.



Edit Object command
Use this command to edit the selected object by opening it in the application used to create
it.

This command changes depending on the type of object selected. For example, if the 
selected object is a Microsoft WordArt object, the command reads "Edit MS WordArt Object."

When you close the object's application, the changes are automatically updated in 
the message.

You can also double-click an object to open the application used to edit it.
Some objects have editing options available from another menu that appears when 

you choose this command.
See Also

Embedding an Object in a Message
Working with an Embedded Object



Edit or Activate Object command
Use this command to activate or edit the selected object. Depending on the type of object, 
you may have several choices on this menu.



Undeliverable Mail notice
The message could not be delivered to the recipient. Your postoffice may not be accessible 
at this time. You can try resending the message by clicking Send Again.



Return Receipt
The return receipt message displays the date and time the message you sent was opened 
by the recipient.



Edit Personal Groups dialog box
Use this dialog box to add names to, or delete names from a personal group.
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Creating or Modifying a Personal Group



Add button
Choose the Add button to add the names(s) selected in the address list to the group.



Directory list
This box displays the list of names in the current directory. To change directories, choose 
the Directory button. To view your Personal Address Book, choose the Personal Address 
Book button.



Group Members
This box lists the members of the personal group. To delete a group member, select the 
name, and then press the DELETE key.



OK    Choose OK to accept the changes and close the dialog box.
Cancel    Choose Cancel to close the dialog box without making any changes.
Help    Choose Help to get information about the options in this dialog box.



New Group dialog box
Use this dialog box to create a new personal group.
New group name    Type the name of the group you want to create. Group names can be 
any length and more than one word.
Create    Choose Create to add the group to your Personal Address Book. The Edit Personal 
Groups dialog box is displayed for you to add group members.
Cancel    Choose Cancel to close this dialog box without creating a new group.

See Also
Creating or Modifying a Personal Group



Open Directory dialog box
This dialog box lists the directories on your Mail system. To select another directory, double-
click the name of the other directory, or use the arrow keys to highlight it and then press 
ENTER.
OK    Choose OK to open the selected directory.
Cancel    Choose Cancel to close this dialog box without opening another directory.
Set Default    Choose Set Default to open the selected directory each time you open the 
Address Book.



New dialog box
Use this dialog box to add the addresses of mail users to your Personal Address Book.
There are two ways to enter custom addresses. You can type an address directly in the 
message you are composing, or you can type the information in this dialog box. If you enter
the information in this dialog box, Mail automatically inserts the correct syntax for the 
address.
Create What Kind Of Entry    Select the type of mail system where the new user address 
is located.
OK    Choose OK to open the New User dialog box for the type of mail directory you have 
chosen.
Cancel    Choose Cancel to close this dialog box without creating a new user entry.

See Also
Updating Your Personal Address Book



Details or New User Dialog Box
The Details dialog box displays information about a user or group. The fields in this dialog 
box depend on the user's mail system. Typically, a combination of the following fields is 
displayed.
Name or Personal Name    This is the name you want to use to refer to the person. It can 
be their full name or an abbreviation.
Group Members    These are the members of the group. To get details about an individual 
group member, double-click the name, or select the name and choose the Details button.
Alias    This is the user's full name on the system.
Address Type    This displays the user's mail system type.
Mailbox, Network, Postoffice    These refer to the user's address.
Comment    You can type a comment in the Details dialog box for a personal group.

 Choose this button to add the name to your Personal Address Book.
New User Dialog Box
The fields in this dialog box vary, depending on the user's mail system. Typically, you need 
to fill in a combination of the following fields. Mail inserts the correct syntax for addressing 
a one-off message when you enter the information in this dialog box.
Personal Name    This is the name you want to use to refer to the person. It can be the 
user's full name or an abbreviation.
Alias    This is the user's full name on the system.
Mailbox, Network, Postoffice    These refer to the user's address.



Attach dialog box
Use this dialog box to include a file in a message.
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Attaching a File



File Name
Type the name of the file you want to include in the message, or select the file from the list.



List Files Of Type
Select the file format you want to display in the list. The default is All Files, which lists all 
files in the current directory.



Directories
Choose the directory where the file you want to attach is located. To open a directory, 
double-click it, or press TAB to move the highlight to the Directories box. Use the arrow keys 
to select the directory, and then press ENTER.



Drives
Choose the drive where the file you want to attach is located.

To choose a different drive, click the down arrow and double click the drive you want, 
or press TAB to move the highlight to the Drives box, press ALT+DOWN ARROW to display the 
available drives, and then use the arrow keys to select a drive.



Attach    Choose Attach to include the file selected in this dialog box in the message. 
Several files can be attached to a message.
Close    Choose Close to close this dialog box.
Help    Choose Help to get information about the options in this dialog box.



Options dialog box
Use this dialog box to choose the options for the open Send Note form. These options allow 
you to:

Request a return receipt. When the recipient opens the message, you are sent a 
receipt.

Save this message in the Sent Mail folder. This option overrides the same option 
available from the Options command on the Mail menu.

Assign a priority to a message. A high-priority message appears in the recipient's 
message list with an exclamation point, and a low-priority message appears with a down-
pointing arrow. The default is normal priority.



Check Names dialog box
This dialog box appears when Mail finds several names that match the name you entered in
the To or Cc line. The list displays the matching names found in the postoffice. Choose the 
message recipient's name from the list.
Click the dialog box region you want information about, or press TAB until the region is highlighted and then press 
ENTER.

See Also
Verifying User Names



Check Names dialog box title
The title line displays the name entered on the To or Cc line.



Matching names list
Choose the message recipient from the list of matching names. Select a name by clicking it 
or by using the arrow keys to move the highlight to the name.

To get more information about a name in the list, double-click the name, or select the
name and then choose the Details button.



OK    Choose OK to enter the selected name as a message recipient.
Cancel    Choose Cancel to close this dialog box without choosing a message recipient.
Details    Choose Details to get more information about the selected name.
Help    Choose Help to get information about the options in this dialog box.



Send Command And Send Note Form
Use the Send command to open a Mail Send Note form with the active document 
automatically included in the message as an attachment.

You can use this command to address and send a message without starting Mail. You 
can attach other files to the message and choose message options as you would in Mail.

If you are not signed in to Mail, the Sign in dialog is displayed and you must sign in 
before the Send Note form is opened.
Send Note Form
Click the form region you want information about, or press TAB until the region is highlighted and then press 
ENTER.



Keyboard Controls for Editing Messages
To Press
Move to the message body TAB
Move to the message heading SHIFT+TAB
Move one character or line arrow keys
Move one word to the left CTRL+LEFT ARROW
Move one word to the right CTRL+RIGHT ARROW
Move to the start of the line HOME
Move to the start of the message CTRL+HOME
Move to the end of the line END
Move to end of message CTRL+END
Start a new paragraph ENTER
Delete the current character DEL
Delete the character to the left BACKSPACE
Move right five spaces TAB



Keyboard Controls for the Address Book
To Press
Open a new directory CTRL+L
Open your Personal Address Book CTRL+P
Find a name CTRL+F
Enter a new address CTRL+N
Add a name to your 
        Personal Address Book CTRL+A
Close the Address Book ESC



To select a single name

Click the name in the address list.

If necessary, press TAB    to move the highlight to the address list, and then use
the arrow keys or PAGE UP, PAGE DOWN, HOME, or END to highlight the name you want to add.
To select multiple names

Hold down CTRL, and click each name you want to add. To select a range of 
names, click the first name, hold down SHIFT, and click the last name.

Hold down CTRL, and then use the arrow keys and press the SPACEBAR to mark 
each name you want to select. To select a range of names, select the first name, hold down 
SHIFT, and use the arrow keys to expand the selection.



 To find a name

1 In the Address Book, choose the Search button (CTRL+F) 
Mail displays the Name Finder dialog box. 

2 Type the name or the first part of the name you're looking for. Mail searches first and last 
names.

3 Choose the Find button.
Mail searches the address list for names that start with the characters you typed. If it 
finds any, they are displayed in the Address Book. You can select names from this list and 
add them to the message. 



Outbox    
The Outbox is a permanent part of the Mail workspace. When you send a message, it is 
temporarily moved to the Outbox until Mail can send it.

When you are working offline, sent mail is stored in the Outbox until you connect to 
your postoffice and sign in.

You can quickly forward messages and files by dragging them to the Outbox.



To select a file

Double-click the filename.
To use the Drives box, click the down arrow in the box and click a drive.
To use the Directories box, double-click a directory.

Press TAB to move the highlight to the list of files and use the arrow keys to highlight 
the file.

To use the Drives box, press ALT+V to move the highlight to the Drives box and 
use the arrow keys to select a drive.

To use the Directories box, press ALT+D to move the highlight to the Directories
list, use the arrow keys to highlight the file, and press ENTER.



To drag a message
Place the mouse pointer over the selected message(s), hold down the left mouse button, 
and drag the pointer over the folder you want to store the message in. When you release 
the mouse button, the message is moved to the folder. (To leave a copy in the original 
folder, hold down CTRL and drag.)



Deleted Mail Folder
The Deleted Mail folder is a permanent folder in your Folders list that stores messages you 
delete. If you display the Deleted Mail folder and then minimize it, the Deleted Mail folder 
icon appears on the Mail workspace. Besides using the Delete button or the Delete 
command on the Edit menu, you can delete messages by dragging them either to the 
Deleted Mail folder or to the Deleted Mail folder icon.
The Options command on the Mail menu provides an option to empty the Deleted Mail 
folder when quitting Mail. If this option is selected, you can retrieve a deleted message from
the Deleted Mail folder until you quit Mail. If the option is not selected, the message stays 
in the Deleted Mail folder until you select and delete it.



Details dialog box
The Details dialog box displays information about a user. This user information is filled in 
either by the administrator or by the user when the account is set up on the postoffice. 
Once this information is entered, only the administrator can change it.
You can change the Name and Comment boxes if you are viewing user details from your 
Personal Address Book. If you change a name, the new name appears in your Personal 
Address Book instead of the Mail user name. You can use this new name to address 
messages.



Folders list
The Folders list displays either your private folders or the shared folders on your postoffice. 
To change the view from private to shared, click the Private Folders button at the top of the 
Folders list.
A plus sign (+) indicates that a folder has subfolders. To view the subfolders, click the plus 
sign, or highlight the folder using the arrow keys and then press PLUS SIGN on the keyboard.
A minus sign (-) indicates that subfolders are displayed. To hide the subfolders, click the 
minus sign, or highlight the folder using the arrow keys and then press MINUS SIGN on the 
keyboard.
To show or hide all folders, press CTRL+PLUS SIGN or CTRL+MINUS SIGN, respectively.



Attachment
An attachment or attached file is a file that is included with a message. The attachment is 
displayed in the message as an icon representing the type of file it is. For example, a 
Microsoft Word document is represented by the Word icon with the name of the file.
If you have the appropriate application on your computer, you can double-click the icon to 
view or edit the attached file.



 To save a file in a different drive or directory

To use the Drives box, click the down arrow in the box, and then click a drive.
To use the Directories box, double-click a directory folder.

To use the Drives box, press ALT+V to move the highlight to the Drives box, and then 
use the arrow keys to select the drive containing the file you want to attach.

To use the Directories box, press ALT+D to move the highlight to the Directories
list, use the arrow keys to select the directory folder you want the file saved in, and press 
ENTER.



To select a message or multiple messages
Click the message name in the message list.

To select multiple messages, hold down CTRL and click the messages.
If necessary, press TAB to move the highlight to the message list, and then use the 

arrow keys or PAGE UP, PAGE DOWN, HOME, or END to highlight the message.
To select multiple messages, hold down CTRL, use the arrow keys to move the 

highlight, and press the SPACEBAR to select the messages.
To select a range of messages

In the message list, drag the pointer in the margin to the left of the message icons.
Hold down SHIFT and use the arrow keys to extend the selection.



Message list 
The message list is the portion of the folder window that displays message headers for the 
messages in the open folder. To move the highlight to the message list, click in the 
message list with the mouse, or press TAB until it's highlighted.



To expand and collapse folders
If the folder has a plus sign (+) next to it, click it to show its subfolders. If the folder 

has a minus sign (-), click it to collapse its subfolders.
Press TAB to move the highlight to the Folders list, use the arrow keys to highlight the 

folder you want to expand or collapse, and press the PLUS SIGN or the MINUS SIGN on the 
keyboard.
To expand all folders in the Folders list

Press TAB to move the highlight to the Folders list and press CTRL+PLUS SIGN.



To open a folder
Double-click the folder.
Press TAB to move the highlight to the Folders list, use the arrow keys to highlight the 

folder, and press ENTER.



Clipboard
The Clipboard is a temporary storage area in your computer's memory for cut or copied 
information.



To select text
Drag with the mouse, or press and hold down SHIFT+arrow keys to highlight the text.



Message file
The message file stores all of your messages and folders. The file has an .MMF extension 
and is stored on your own computer.
You can import folders from another message file or export folders to another message file 
using the Import Folder and Export Folder commands.



User name
A unique name is assigned to each Mail user by the administrator or by the user when the 
account is set up. Use this name to address messages to the user. 
You can either type the name in the To or Cc box in a Send Note form or choose the Address
button and choose the name from the Address Book.



Sent Mail folder
The Sent Mail folder is a permanent folder in the folder list.
If you want to keep a copy of the messages you send, choose the Options command from 
the Mail menu and select the "Save Copy Of Outgoing Messages In Sent Mail Folder" check 
box.



Insertion point
The insertion point is a blinking vertical bar that indicates where text you type will appear, 
or where the contents of the Clipboard will be placed if you choose the Paste command 
from the Edit menu.
You position the insertion point by clicking with the mouse or by using the arrow keys.



Inbox
The Inbox folder is a permanent folder in the Folders list; you can't delete it.
New messages you receive are stored in the Inbox.



Postoffice
The postoffice is a directory on one of the computers in your workgroup. The postoffice 
stores the Mail files that establish and control access to Mail. 
If the computer that has the postoffice is not online, you can still work with Mail but you 
cannot send or receive messages.



Password
Your password is a word or group of characters that you type to gain access to your mail. 
You enter your password when you sign in to Mail the first time. If an account has already 
been set up for you, your administrator may have given you a password already. After 
signing in the first time, you should change your password to one that is easy to remember.



Selecting Folders for Import or Export
To select folders in the Import Folders or Export Folders dialog box:

Click the folder you want to select. To cancel a folder selection, click the folder again.
To select multiple folders, hold down CTRL while selecting the folders.
To extend a selection from one folder to another, hold down the SHIFT key while 

selecting the second folder.



Multiple Selection Rules For Importing or Exporting Folders
When you select a folder, all its subfolders are also selected.
A single folder selected at any level is created at the top level of the destination message 
file.
If you don't want to copy all the subfolders under a selected folder, you can cancel the 
selection of those folders. The folders necessary to maintain the folder hierarchy between 
selected subfolders are maintained. If you have canceled the selection of these folders, 
they will be empty in the destination folder and serve only as placeholders.



Exporting Mail Folders
You can move or copy folders and the messages they contain from your message file to an 
export message file.
You can export folders to archive messages according to their date, or to create a smaller 
message file that can be copied onto a portable computer, or to give other users access to 
specific folders.
To export folders, choose the message file you want to export the folders to. Then select the
folders you want to export from your primary message file. You can export all the folders in 
your Folders list or only those you select. If you select a folder with subfolders, the 
subfolders are also exported.



Exporting Mail Folders

To export one or more Mail folders
1 From the File menu, choose Export Folder (ALT, F, E).
2 Select the message file (.MMF file) you want to export messages to and choose the OK 

button.
If you want to create a new message file, type the name for the new file in the File Name 
box and choose OK.

3 If applicable, type the password for the message file.
You are prompted for a password only if the message file you selected is password 
protected.

4 Select the All Folders option button to export all the messages in your message file, or 
select the Selected Folders option button to export only the folders you select. Then 
select the folders you want to export.
If you select a folder with subfolders, the subfolders are also exported. There are multiple 
folder selection rules that specify what happens when you select some but not all the 
subfolders.

5 To export messages within a date range, choose the Options button. In the Options dialog
box you can choose to export all the messages in the selected folders, or only those 
messages received or modified during a specified date range.

To export all messages received after a specific date, select the From check box and 
enter the date.

To export all messages received before a specific date, select the To check box and 
enter the date.

To export messages between two dates, select both check boxes. Enter the earlier 
date in the From box and the later in the To box.
6 Choose the Copy button to copy the selected folders to the export message file, or 

choose the Move button to move the selected folders to the export message file.
If there are folders with the same name in both the export and primary message files, 
Mail prompts you to choose how you want to resolve conflicting folder names.

7 Choose the Close button.

See Also
Export Folder command
Import Folder command
Importing Mail Folders



Conflicting Folder Names
If the name of the folder you are importing 
or exporting conflicts with a folder of the 
same name in the destination message 
file, you can choose one of the following 
options to resolve the conflict.
Save Latest Version Of All Messages    
Mail checks the message ID and the 
modification dates of all duplicate 
messages and moves or copies the 
message only if it is the latest version.
Save All Messages    All messages are 
saved in both folders. If the duplicate 
messages are identical, the messages are 
not copied or moved. If there are two 
versions of a message, both versions are 
saved.
Rename Destination Folder    You are 
prompted for a new name for the folder 
you are moving or copying.

Importing Mail Folders
You can move or copy Mail folders from another message file to your primary message file. 
These mail folders can be from either a backup message file or a message file you exported
folders to temporarily.
If you are importing Mail folders that you previously exported, or that have the same names
as folders in your primary message file, you can choose how the messages are merged into
your folders.



Importing Mail Folders

To import one or more Mail folders
1 From the File menu, choose Import Folder (ALT, F, I).
2 Select the message file (.MMF file) you want to import messages from and choose the OK 

button.
3 If applicable, type the password for the message file.

You are prompted for the password only if the message file is password protected.
4 Select the All Folders option button to import all the messages into your primary message

file, or select the Selected Folders option button to import only the folders you select. 
Then select the folders you want to import.
If you select a folder with subfolders, the subfolders are also imported. There are multiple 
folder selection rules that specify what happens when you select some but not all the 
subfolders.

5 To import messages within a date range, choose the Options button. In the Options dialog
box you can choose to import all the messages in the selected folders, or only those 
messages received or modified during a specified date range.

To import all messages received after a specific date, select the From check box and 
enter the date.

To import all messages received before a specific date, select the To check box and 
enter the date.

To import messages between two dates, select both check boxes. Enter the earlier 
date in the From box and the later in the To box.
6 Choose the Copy button to copy the selected folders to your primary message file, or 

choose the Move button to move the selected folders to your primary message file.
If there are folders with the same name in both the export and primary message files, 
Mail prompts you to choose how you want to resolve conflicting folder names.

7 Choose the Close button.

See Also
Export Folder command
Exporting Mail Folders
Import Folder command



File Menu Commands

Export Folder
Use the Export Folder command to move or copy Mail folders into another message file.

You can export selected folders or all your folders. Only the messages in the selected 
folders are exported.

When you export a subfolder, it is moved to the top level in the export message file. 
If you want to select some but not all the subfolders, the multiple folder selection rules 
specify what messages are exported.

You can create a new backup message file when you export folders. Backup message 
files are not password protected.

You can select a date range for the messages you want to export.
Export File Name Dialog Box Options
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.

See Also
Exporting Mail Folders
Import Folder command
Importing Mail Folders



File Name
This box displays the name of the message file you are exporting folders to. Message files 
have an .MMF extension. You can choose an existing message file or create a new one. To 
create a new message file, type a name for it.



List Files of Type
The default file type is message file (files with an .MMF extension).



Directories
Choose the directory where the message file you want is located. To open a directory, 
double-click it, or press TAB to move the highlight to the Directories box. Use the arrow keys 
to select the directory, and then press ENTER.



Drives
Choose the appropriate drive.

To choose a different drive, click the down arrow and double-click the drive you want, 
or press TAB to move the highlight to the Drives box. Then press ALT+DOWN ARROW to display 
the available drives, and use the arrow keys to select a drive.



OK    Choose OK to open the selected message file.
Cancel    Choose Cancel to close this dialog box without selecting a file.
Help    Choose Help to display the Help topic describing the options in this dialog box.
Network    Choose Network to select the server and shared directory that contains the 
message file with the folders you want to export.



Export Folders Dialog Box
Choose the folders you want to copy or move to the message file displayed on the File 
Name line.
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.



File Name
This line displays the name of the message file you are exporting folders to.



Folders To Export
Select the folders you want to export.

You can export all folders or only the folders you select in the Folders list.
All subfolders are displayed in the Folders list. When you select a folder, all its 

subfolders are also selected. You can cancel the selection of subfolders you don't want to 
export.



Move    Choose Move to move the selected folders from your primary message file to the 
export file. The contents of selected folders are removed from your primary message file, 
but the empty folders are not deleted.
Copy    Choose Copy to copy the selected folders to the export message file.
Close    Choose Close to close this dialog box when you have finished copying or moving 
folders into the export message file.
Options    Choose Options to select a date range for the messages you want to export.
Help    Choose Help to display the Help topic describing the options in this dialog box.



File Menu Commands

Import Folder
Use the Import Folder command to move or copy Mail folders from another message file to 
your primary message file.

When you import a folder with subfolders, all the subfolders are imported. You can 
cancel the selection of subfolders that you don't want to import.

If a message file is protected with a password, you need to provide the password 
before you can import folders.
Import File Name Dialog Box Options
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.

See Also
Export Folder command
Exporting Mail Folders
Importing Mail Folders



File Name
This box displays the name of the message file you are importing folders from. Message 
files have an .MMF extension.



List Files of Type
The default file type is message file (files with an .MMF extension).



Directories
Choose the directory where the message file you want is located. To open a directory, 
double-click it, or press TAB to move the highlight to the Directories box. Use the arrow keys 
to select the directory, and then press ENTER.



Drives
Choose the appropriate drive.

To choose a different drive, click the down arrow and double-click the drive you want, 
or press TAB to move the highlight to the Drives box. Then press ALT+DOWN ARROW to display 
the available drives, and use the arrow keys to select a drive.



OK    Choose OK to display the folders available in the selected message file.
Cancel    Choose Cancel to close this dialog box.
Help    Choose Help to display the Help topic describing the options in this dialog box.
Network    Choose Network to select the server and shared directory that contains the 
message file with the folders you want to import.



Import Folders Dialog Box
Choose the folders you want to copy or move from the message file displayed on the File 
Name line.
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.



File Name
This line displays the name of the message file you are importing folders from.



Folders To Import
Select the folders you want to import.

You can import all folders or only the folders you select in the Folders list.
All subfolders are displayed in the Folders list. When you select a folder, all its 

subfolders are also selected. You can cancel the selection of subfolders you don't want to 
import.



Move    Choose Move to move the selected folders from the import file to your primary 
message file. The contents of the selected folders are removed from the import file but the 
empty folders are not deleted.
Copy    Choose Copy to copy the selected folders into your primary message file.
Close    Choose Close to close this dialog box when you have finished copying or moving 
folders from the import message file.
Options    Choose Options to select a date range for the messages you want to import.
Help    Choose Help to display the Help topic describing the options in this dialog box.



Options Dialog Box
You can import or export all messages or messages within a specific date range.
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.



All Messages    Select this option to import or export all the messages in the selected 
folders.
Messages Received or Modified    Select this option to save messages within the date 
range specified in the From and To boxes.
From    Select this check box to import or export messages received after the date entered 
in the date box.
To    Select this check box to import or export messages received before the date entered in
the date box.
To import or export messages that you received between two dates, select both check 
boxes and enter the earlier date in the From box and the later date in the To box.



OK    Choose OK to accept the selected date range.
Cancel    Choose Cancel to close this dialog box without specifying a date range.
Help    Choose Help to display the Help topic describing the options in this dialog box.



Duplicate Folder Name Dialog Box
If two folders exist with the same name in both the primary message file and the import or 
export message file, you are given three options to resolve the name conflict.
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.



Save Latest Version Of All Messages
Mail checks the message ID and the modification dates of all duplicate messages and 
moves or copies the message only if it is the latest version.



Save All Messages
All messages are saved in both folders. If the duplicate messages are identical, the 
messages are not copied or moved. If there are two versions of a message, both versions 
are saved.



Rename Destination Folder
You are prompted for a new name for the folder you are moving or copying.



Don't Prompt On Remaining Duplicate Folder Names
Select this check box if you want all folders with duplicate names to be handled the same 
way. If you do not select this option, you are prompted each time a duplicate name is found.



OK    Choose OK to accept the selected options.
Cancel    Choose Cancel to close this dialog box without making a selection.
Help    Choose Help to display the Help topic describing the options in this dialog box.



Rename Folder Dialog Box
Folders with the same name exist in both the primary message file and you have chosen 
the Rename Destination Folder option. Enter the new folder name for the destination folder.
Click the region of the dialog box you want information about, or press TAB until the region is highlighted, and then
press ENTER.



Enter The Name Of The New Folder
Type the new name for the folder you are importing or exporting.



OK    Choose OK to resolve the conflicting folders by changing the folder name.

Cancel    Choose Cancel to close this dialog box without changing the folder name.

Help    Choose Help to display the Help topic that describes the options in this dialog box.



Postoffice Manager
Use the Postoffice Manager command to manage a Workgroup Postoffice (WGPO). The 
Postoffice Manager command appears only on the administrator's Mail menu; it displays the
Postoffice Manager dialog box.
For more information on the Postoffice Manager command and on managing a Workgroup 
Postoffice, see the Mail User's Guide.
With the Postoffice Manager, you can:

Add users to the WGPO.
Modify existing user accounts.
Remove users from the WGPO.
Compress shared folders to manage the disk space where the WGPO is installed.



Meeting Request Message Form
This is the Meeting Request message form from Schedule+. You can accept, decline, or 
tentatively schedule the requested meeting.

If you accept the meeting, it is automatically booked in your schedule.
If you check the Send Response box, your response is sent to the meeting organizer.

Click the message form region you want information about, or press TAB until the region is highlighted, and then 
press ENTER.



Accept    Choose this button to accept this meeting. The meeting is automatically added to 
your Appointment Book.
Decline    Choose this button to decline this meeting.
Tentative    Choose this button to tentatively accept this meeting time. The meeting is 
automatically added as a tentative appointment in your Appointment Book.
View Schedule    Choose this button to view your schedule before replying to this meeting 
request.



This area contains the name of the person who is organizing the meeting, the meeting 
time, and other details of the meeting request.
If you select the Send Response check box, the meeting organizer is sent your response.



This section contains any additional notes sent with the meeting request. You cannot edit 
this field. If you send a response, you can edit the text field in the Send Response form.



Meeting Canceled Message Form 
This is the Meeting Canceled message form from Schedule+.

This message appears whenever a meeting has been canceled by the meeting 
organizer. The word "Canceled" in the subject line indicates that the meeting is canceled.
Click the message form region you want information about, or press TAB until the region is highlighted, and then 
press ENTER.



Remove from Schedule    Choose this button to remove the meeting from your 
Appointment Book.
View Schedule    Choose this button to view your schedule before canceling the meeting in
your Appointment Book.



This area contains the name of the person who is canceling the meeting, the meeting time, 
and other meeting details.



This section contains any additional notes sent with the meeting cancellation.



Send Response Message Form
This is the Send Response message form from Schedule+.
Click the message form region you want information about, or press TAB until the region is highlighted, and then 
press ENTER.



Send    Choose this button to send a meeting response to the meeting organizer.
Cancel    Choose this button to close the Send Response dialog box without sending a 
response.



This area of the dialog box contains the name of the person who sent the meeting request. 
The subject line indicates whether the attendee has accepted, tentatively accepted, or 
declined the meeting request.



This section of the dialog box contains any additional notes to be sent with the reply.



Forward Meeting Request Message Form
This is the Forward Meeting Request message form from Schedule+. Use this form to 
forward a meeting request.
Send button    Choose this button to send the meeting request to the name on the To line.
Check Names button    Choose this button to verify the user name on the To line.
Address button    Choose the button to open the Address Book.
To:    Type the name of the person you want to forward the meeting request to or choose a 
name from the Address Book.
Subject:    This line displays the meeting subject.
When:    This line displays the meeting date and time.



Meeting Response Message Form
This is the Meeting Response message form for Schedule+. This message indicates whether
or not a person can attend a meeting you organized.
View Schedule    Choose this button to open Schedule+ and display your schedule.



Using Mail's Address List
Each Mail user has a unique user name stored in his or her postoffice. If you know the user 
names of the people you want to send a message to, you can type them directly in the 
address boxes of a Send Note form.
If you don't know the user names, you can find them in the Address Book. From the Address
Book, you can view user names in your postoffice or user names in your Personal Address 
Book. You can then select names from the list and add them to your address boxes.



Using Mail's Address List

The Address Book lists users in your postoffice. You also access your Personal Address Book 
from it.
To add recipients from the address list
1 Choose the Compose button, or from the Mail menu, choose Compose Note (ALT, M, N).
2 Choose the Address button to display the Address Book with the list of users in your 

postoffice.
3 Press a key to scroll the list to the first name beginning with that letter. To scroll to 

another letter, press BACKSPACE and then the letter.
To find a name, choose the Search button  or press CTRL+F.

4 To add names from the address list to the To or Cc box, do one of the following:
Select the name in the address list and choose the To or Cc button.
Double-click the name in the address list to add it to the To box.
Drag the name from the address list to the To or Cc box.
Press TAB to move the insertion point to the To or Cc box and type the names, 

separated by semicolons (;).
To remove a name, select it and press BACKSPACE or DEL.

5 To return to the Send Note form, choose OK.
To add recipients from your Personal Address Book
1 In the Address Book, choose the Personal Address Book button  or press CTRL+P.

Your Personal Address Book shows the users you've selected from the address list. It 
also contains the personal groups you've created.
2 Select the recipients and choose the To or Cc button.
See Also

Creating or Modifying a Personal Group
Getting Details About a User
Updating Your Personal Address Book
Verifying User Names



Directory button      
Choose the Directory button to choose either the postoffice list or your Personal Address 
Book.

The mail directory that is currently open is selected. To open another directory, select
it and choose the OK button.



Personal Address Book button    
You can store the names of people you frequently send messages to in your Personal 
Address Book.

Your Personal Address Book can contain any name in the postoffice list.



Updating Your Personal Address Book
You can store the names of mail recipients you frequently send messages to in your 
Personal Address Book.
Your Personal Address Book can contain any name in the postoffice list.



Updating Your Personal Address Book
    
 Add Names button
 Directory button
 Personal Address Book button

To add a name to your Personal Address Book
1 From the Mail menu, choose Address Book (ALT, M, D).
2 From the address list, select the name and choose the Add Names button or press CTRL+A.
3 To close the Personal Address Book, press ESC.

Note    You can also add names to your Personal Address Book when composing a message 
by selecting the names in the Address Book and choosing the Add Names button (CTRL+A).
To remove a name from your Personal Address Book
1 From the Mail menu, choose Address Book (ALT, M, D).
2 Choose the Personal Address Book button or press CTRL+P.
3 Select the name that you want to remove.
4 Choose the Remove button.
Note    You can also remove names from your Personal Address Book when composing a 
message by choosing the Personal Address Book button, selecting the names in the address
list, and choosing the Remove button.

See Also
Creating or Modifying a Personal Group
Using Mail's Address List



Add Names button
 Add Names button

Choose the Add Names button to add a name to your Personal Address Book.



Attaching a File
You can include any file you have access to in a message. The file can be on your hard disk,
a floppy disk, or the network. Files can be application files, such as Microsoft Word or 
Microsoft Excel files, batch files, programs, or graphics files.
An attached file appears in the body of your message as an icon with a filename. If 
recipients have the appropriate application, they can open the file directly from the 
message. They can also save the file directly to their computer's hard disk.
Note that Mail sends a copy of the file and leaves the original in the source location.



Attaching a File
    

You can attach a file to a message with the Attach button, or you can drag the file from the 
File Manager to a message. 
To attach a file
1 Click the Compose button, or from the Mail menu, choose Compose (ALT, M, N).
2 Move the insertion point to the location in the body of the message where you want the 

file icon to appear.
If you don't specify a location, the file icon is inserted at the beginning of the message.

3 Choose the Attach button.
4 Type the path and filename in the File Name box, or select a file by using the Drives and 

Directories boxes.
The file's icon appears in the message body.

5 Repeat steps 3 and 4 until you have attached all the files you want, and then choose the 
Close button.

To drag a file from the File Manager
1 Click the Compose button, or from the Mail menu choose Compose Note (ALT, M, N).
2 Display the File Manager window.
3 In the File Manager, locate the file you want to attach to the message.
4 Drag the file icon where you want it to appear in the message.
Note  You can drag a file icon from the File Manager to the Outbox on Mail's workspace. 
When you drop the file icon, a Send Note form appears, with the file icon in the message 
body.

See Also
Copying Information Between Messages
Embedding an Object in a Message



Backing Up and Restoring Your Message File
Your messages and folders are stored in a message file that you keep on your computer. 
Your message file is updated when you receive a new message or work with a message or 
folder in your mailbox.
As with any other file, it's a good practice to regularly back up your message file. Then, if 
there's a problem with the computer containing your message file, you can recover your 
mail from the last backup file.



Backing Up and Restoring Your Message File

To back up your message file
1 From the Mail menu, choose Backup (ALT, M, B).
2 In the File Name box, specify where you want the backup stored.
3 Choose the OK button.
To restore a backup message file
If you try to start Mail and it can't locate your message file, a dialog box appears asking you
to choose a message file. 
1 Locate the backup file.

Mail asks if you want to convert the backup file to your message file.
2 Choose the OK button.

The backup file becomes your message file, and your mailbox opens to display the 
messages and folders you had when you backed up the file. New messages you receive 
will be added to the Inbox.

Note    If you don't convert the backup file, you can read the messages in the file, delete 
them, and move them to folders. However, you won't be able to send or receive new 
messages.

See Also
Exporting Mail Folders
Importing Mail Folders
Signing In to or Out of Mail
Working Offline



Changing Your Password
It is a good idea to periodically change your password for security purposes.
Choose a password that is easy for you to remember. If you forget your password, have 
your administrator assign you a new one.



Changing Your Password

To change your password
1 From the Mail menu, choose Change Password (ALT, M, C).
2 Type your old password and press TAB.

For security, you do not see the characters as you type them.
3 Type your new password and press TAB. Passwords are case sensitive.
4 To verify the new password, type it again and choose the OK button.

Note    The OK button remains unavailable until your new password and the verification of
your new password match exactly. 

Your new password is registered; you'll be required to use it the next time you sign in to 
Mail.
See Also

Signing In to or Out of Mail



Copying Information from a File
If you have information in a file of one of your Windows applications, you can copy the 
information from the file to the Clipboard and paste it into your message. In this case, you 
are including information from the file, not the file itself.
You can also insert the contents of a text file directly into a message using the Insert From 
File command.



Copying Information from a File

To copy information from a file
1 Open the file that contains the information.
2 Select the information you want to copy.
3 From the Edit menu, choose Copy.

Mail copies the information to the Clipboard.
4 Switch to the message you are composing, or open a new Send Note form.
5 In the body of the message, move the insertion point to the location where you want to 

paste the information.
6 From the Edit menu, choose Paste (ALT, E, P).
Note    You can use this procedure to copy information from an MS-DOS application if the 
application can access the Windows Clipboard. See the application's documentation for 
information about using the Windows Clipboard.
To copy text from a text file into a message
1 From the Edit menu, choose Insert From File (ALT, E, F).
2 Select the text file you want to copy into the message.
3 Choose the OK button.

The entire contents of the text file are copied into the message.

See Also
Attaching a File
Copying Information Between Messages
Embedding an Object in a Message



Copying Information Between Messages
If a message contains information that you want to include in another message, you can 
copy and paste the information. 



Copying Information Between Messages

To copy information from another message
1 Display the message you want to copy from.
2 Select the information you want to copy.
3 From the Edit menu, choose Copy (ALT, E, C), and then close the message by pressing ESC.
4 From the Window menu, choose the message you are composing, or click the Compose 

button (CTRL+N) to display a new Send Note form.
5 Move the insertion point to the location where you want to paste the information.
6 From the Edit menu, choose Paste (ALT, E, P), or press CTRL+V.

See Also
Copying Information from a File
Embedding an Object in a Message



Creating a Folder or Subfolder
You can create folders for storing and organizing your messages. Folders can contain other 
folders, called subfolders.
Folders can be "private" or "shared." Only you can see and use your private folders. Private 
folders are stored in your message file on your computer's hard disk.
With a shared folder, all users in your postoffice with shared folder privileges can open the 
folder and see the messages it contains. By choosing access rights, you determine whether 
others can read the contents of each message, add messages, or delete messages.



Creating a Folder or Subfolder

To create a folder
1 With the Folders list displayed, choose New Folder from the File menu (ALT, F, N).
2 In the Name box, type a name for the folder.

A folder name can consist of any combination of characters and spaces. 
3 Under Type, select Private or Shared.

For a description of private and shared folders, see the Overview.
4 To assign access permissions to a shared folder, choose the Options button, select the 

permissions in the Other Users Can box.
5 Choose the OK button.

The folder is included in the Folders list in alphabetic order.
To rename a folder
1 In the folder list, select the folder name you want to change.
2 From the File menu, choose Folder Properties (ALT, F, F).
3 Type the new folder name, and then choose the OK button.
To create a subfolder
1 From the New Folder dialog box, choose the Options button.
2 In the Name box, type a name for the subfolder.
3 Under Level, select the Subfolder Of option button, select a folder, and then choose the 

OK button.
Note If a folder is selected in the folder list, any new folder you create is a subfolder of the 
selected folder.
To make a subfolder a top-level folder
1 From the File menu, choose Folder Properties (ALT, F, F).
2 In the Level box, select the folder you want to move.
3 Select the Top Level Folder option, and then choose the OK button.

See Also
Deleting a Folder
Expanding and Collapsing Folders
Moving a Folder Within a Folder
Moving Messages Between Folders



Creating or Modifying a Personal Group
You can create a personal group in which you assign multiple Mail users a single name. 
When you add that group name to the recipient list for a message, each individual receives 
the message.
Personal groups are stored in your Personal Address Book and are displayed in bold text.



Creating or Modifying a Personal Group

To create a personal group
1 From the Mail menu, choose Personal Groups (ALT, M, G).
2 Choose the New button.
3 In the New Group Name box, type a name for the group and choose the Create button.
4 The Address Book is displayed.
5 To add names from the address list to your group, select the name(s) and choose the Add 

button or press ALT+A.
-or-
Type the names directly in the Group Members box.

6 Choose the OK button.
To add or remove a name from a personal group
1 From the Mail menu, choose Personal Groups (ALT, M, G).
2 In the Groups list, select the name of the group you want to modify.
3 Choose the Edit button.

The Address Book appears with the group members listed in the bottom box. 
4 Add or remove a group member:
 To add a name, select it from the address list and choose the Add button or type the 

name in the Group Members box.
 To remove a name, select it from the list and press DEL or BACKSPACE.

5 Choose the OK button.
6 Choose the Done button in the Personal Groups dialog box.

See Also
Updating Your Personal Address Book
Using Mail's Address List



Deleting a Folder
When you delete a folder, the messages in it and in all of its subfolders are moved to the 
Deleted Mail folder.
You can retrieve messages from the Deleted Mail folder until they are deleted. Using the 
Options command on the Mail menu, you can choose to have the Deleted Mail folder 
emptied whenever you quit Mail.



Deleting a Folder

To delete a folder
1 In the folders list, select the folder you want to delete.
2 Click the Delete button, or from the File menu, choose Delete (ALT, F, D).

The messages in the folder and any of its subfolders are moved to the Deleted Mail folder
. You can retrieve messages and folders from the Deleted Mail folder. 
Depending on the options you've chosen in the Options command from the Mail menu, 
the messages are either kept in the Deleted Mail folder until you quit Mail, when they are 
deleted permanently, or they remain in the Deleted Mail folder.

See Also
Creating a Folder or Subfolder
Deleting or Retrieving a Message
Expanding and Collapsing Folders
Setting Mail Options



Deleting or Retrieving a Message
When you delete a message, it's moved to the Deleted Mail folder. The Options command 
on the Mail menu provides an option to empty the Deleted Mail folder when you quit Mail. If
this option is selected, you can retrieve a deleted message from the Deleted Mail folder 
until you quit Mail. If the option is not selected, the message stays in the Deleted Mail 
folder until you select and delete it in the Deleted Mail folder.



Deleting or Retrieving a Message

You can delete a message you are reading, or you can select and delete one or more 
messages in the message list.
To delete a message you are reading

Click the Delete button, or from the File menu, choose Delete (ALT, F, D).
To delete a message in the message list

Drag the selected message(s) to the Deleted Mail folder.
Select the message(s), and from the File menu, choose Delete (ALT, F, D). The 

message(s) are moved to the Deleted Mail folder.
Note    When you delete a message, the next message in the message list is opened, in 
chronological order.
To retrieve a deleted message
1 Open the Deleted Mail folder.
2 Select the message(s) you want to retrieve.
3 Drag the message(s) to another folder, or from the File menu, choose Move (ALT, F, M), and 

select a folder from the list.

See Also
Deleting a Folder



Finding a Message
You can use Mail's Message Finder command to find messages stored in the Inbox or other 
Mail folders.
You can find a message by specifying:

Who sent it.
What the subject was.
Who the recipients were.
Any text in the message body.
Which folders to search.



Finding a Message

To search for a message
1 From the File menu, choose Message Finder (ALT, F, G).
2 Fill in the boxes with the information you want to find.

Example
3 To specify the folder(s) to be searched, choose the Where to Look button and select all 

folders or a specific folder, then choose the OK button.
4 Choose the Start button.

Mail searches the folder(s) you specified and lists the messages as it finds them. 
When the message you're searching for is listed, choose the Stop button.
You can read and process messages in the Message Finder window as you do in any other
folder. If you delete a message in the Message Finder window, it's also deleted from the 
folder it's stored in.

Tip    If you frequently search for messages containing specific information, you can 
minimize the Message Finder window and leave it on the Mail workspace. Then, when you 
want to find a message, expand the window and choose the Start button. You can have as 
many Message Finder windows as you want.
See Also

Deleting or Retrieving a Message
Reading a Message



Example
You can include multiple criteria in a search box by separating the items with semicolons.
For example, to find messages from Nick Holtz and Pamela McKee with the words 
"production reports" in the subject, you would type "Nick Holtz; Pamela McKee" in the From 
box and "production reports" in the Subject box.



Forwarding a Message
You may want to forward a copy of a message you receive to other Mail users. You can 
include your own comments in the body of the message.
When you forward a message, the subject of the original message is entered in the Subject 
box, preceded by the prefix FW: (for Forward).
When forwarding a message, you can use all the features you use when sending mail, such 
as attaching files. Files that are attached to a message are forwarded along with it.



Forwarding a Message

You can forward a message that's either open or selected in the message list.
To forward a message
1 Click the Forward button, or from the Mail menu, choose Forward (CTRL+F).
2 In the To box, specify the recipient(s) of the message.
3 To add comments, press TAB to move the insertion point to the message body and type.
4 Choose the Send button.
Tip  You can also drag the message from the message list to the Outbox. When you drop 
the message, a Send Note form appears with the text of the original message. You can then
address the message and send it.

See Also
Attaching a File
Replying to a Message
Using Mail's Address List



Getting Details About a User
When adding a user to a postoffice, the administrator or the person setting up the account 
can include personal information such as department, office location, and telephone 
number. When you have the Address Book displayed, you can view this information by 
selecting a name and choosing the Details button.



Getting Details About a User

To get details about a user
1 From the Mail menu, choose Address Book (ALT, M, D).
2 Select the user name. 
3 Choose the Details button.

Mail displays the Details dialog box.
Tip    You can also get details about a user by double-clicking any name in the Address Book
or names in the To or Cc boxes in message forms.

See Also
Updating Your Personal Address Book
Using Mail's Address List



Embedding an Object in a Message
Some Windows applications can create objects that you can include in your Mail messages 
with the Paste Special command. When an object is pasted into Mail, it's called an 
embedded object.
One advantage of embedding an object over simply copying and pasting the information is 
that you can subsequently edit the content of the object in Mail. For example, if you select 
a range of cells in Microsoft Excel for Windows and paste them into Mail as an object, you 
can later double-click the object to launch Excel, modify the numbers, and update the 
object in Mail. Another advantage is that an embedded object retains the formatting and 
other characteristics it had in the application that created it.
You can also create an object to include in your message. Choose the Insert Object 
command in Mail to display a list of applications that you can use to create objects.



Embedding an Object in a Message

To embed an object in a message
1 Open the document that has the information you want to include in the message and 

copy the information to the Clipboard.
2 Switch to Mail.
3 Click the Compose button, or from the Mail menu, choose Compose Note (ALT, M, N).
4 From the Edit menu, choose Paste Special (ALT, E, S).
5 In the Data Type list, select the object format. 
6 Choose the Paste button.
To create and embed a new object within Mail
1 In the Send Note form, move the insertion point to the location where you want to insert 

the object.
2 From the Edit menu, choose Insert Object (ALT, E, I).

The Insert Object dialog box lists the Windows-based applications that can create objects.
3 Select the application you want to use and choose the OK button.

The application's window opens on top of the Mail window.
4 Create the object.
5 From the application's File menu, choose Update, or close the application.

The object is inserted in your message.

See Also
Attaching a File
Working with an Embedded Object



Setting Message Options 
When you compose a message, you can select the following options:

To be notified when the recipient reads the message.
To save a copy of the message in the Sent Mail folder.
To set a priority for the message.



Setting Message Options

To set message options
1 In the Send Note window, choose the Options button.
2 Select the options you want:

To receive a return receipt message when a recipient reads your message, select the 
Return Receipt check box. 

To save a copy of the message in the Sent Mail folder, select the Save Sent Messages
check box.

To set a priority for the message in the recipient's message list, select the High, 
Normal, or Low option.
3 Choose the OK button.

See Also
Sending a Message
Setting Mail Options



Creating and Using a Message Template
If you often send the same type of message to the same people, you can preaddress a 
message template and forward it to the group whenever you need to send the message.
Note that you must forward the message to leave the original template in your mailbox. As 
with any other message that you forward, you can change the recipients or message body 
without affecting the original.



Creating and Using a Message Template

To create a message template
1 Click the Compose button, or from the Mail menu, choose Compose Note (ALT, M, N).
2 Address the message to the people you will be sending it to regularly. 
3 Type the subject and template information.
4 Close the message window by double-clicking the Send Note window's close box or by 

pressing CTRL+F4.
Mail asks if you want to save the message.

5 Choose the Yes button.
To use a message template
1 Display the message for forwarding by doing one of the following:

Select the message, and from the Mail menu, choose Forward (ALT, M, F).
Drag the message header to the Outbox icon.

2 Fill in the message. If necessary, change the list of recipients.
3 Choose the Send button.
Tip    You may find it convenient to store all your message templates in a single folder.

See Also
Creating a Folder or Subfolder
Moving Messages Between Folders
Using Mail's Address List



Moving Messages Between Folders
You can move or copy messages from one folder to another. When you move a message, it 
is removed from its original location. When you copy a message, the copy is stored in both 
the original folder and the destination folder.



Moving Messages Between Folders

You can move a message that is open or selected in the message list.
To move or copy a message that is open

1 Click the Move button, or from the File menu, choose Move (ALT, F, M) or Copy (ALT, F, 
C).

2 In the Move To or Copy To box, select the folder you want to move the message to.
If you need a new folder, choose the New button and type a name for the folder.

3 Choose OK.
To move or copy a selected message

Drag the message from the message list to the folder in the folders list.
1 From the File menu, choose Move (ALT, F, M) or Copy (ALT, F, C).
2 In the Move To or Copy To box, select the folder you want to move the 

message to.
If you need a new folder, choose the New button and type a name for the folder.

3 Choose OK.
Note  When you move a message, the next message in the message list is opened, in 
chronological order.

See Also
Creating a Folder or Subfolder
Expanding and Collapsing Folders
Moving a Folder Within a Folder



Moving a Folder Within a Folder
Folders can contain other folders, called "subfolders." Using subfolders, you can organize all
your saved messages. 
For example, you can create a folder called My Mail that contains another folder called 
January Messages. You might want to save miscellaneous messages in the My Mail folder, 
but save only those messages you received in January in the January Messages folder. 
A subfolder must be the same type (shared or private) as the folder it's stored in: You 
cannot create a shared folder within a private folder or a private folder within a shared 
folder.



Moving a Folder Within a Folder

To move a folder within a folder

In the folders list, drag the folder you want to move to the folder you want to store it 
in.

1 In the folders list, select the folder you want to move.
2 From the File menu, choose Move (ALT, F, M). Or, to leave a copy of the folder in 

its original location, choose Copy (ALT, F, C).
3 In the Move To box, select the folder you want to store the subfolder in and 

choose the OK button.
Note    You can also move folders with the Folder Properties command on the File menu.
Tip  To promote a subfolder to a top-level folder, drag the subfolder anywhere in the folder 
list while holding down the HOME key.

See Also
Creating a Folder or Subfolder
Expanding and Collapsing Folders
Moving Messages Between Folders



Opening and Saving an Attachment
Attached files appear as icons in the body of a message. If you have the corresponding 
application available on your computer, you can open the file from the message. You can 
also save the file to any disk or server available to your computer.



Opening and Saving an Attachment

To open a file attached to a message

In the message body, double-click the file icon.
1 Use SHIFT+arrow keys to select the file icon.
2 From the File menu, choose Open (ALT, F, O).

To save an attached file
1 From the File menu, choose Save Attachment (ALT, F, A).
2 Save the file in one of these ways:
    To save an attached file in the current directory, select it in the Attachments list and 

choose the Save button. If multiple files are attached, you can save all of them in the current
directory by choosing the Save All button.

    To save a selected file under a different filename, type it in the File Name box.
    To save the file in a different directory, choose the drive and directory where you want to

save the file.
3 When you've saved all the files, choose the Done button.

See Also
Attaching a File



Printing a Message
You can print a message that is open, or you can print one or more messages that you've 
selected in the message list. If you select more than one message, the messages print in 
the same order as they appear in the message list. You have the option of printing the 
messages continuously with no page breaks or printing each message on a new page.



Printing a Message

You can print a message that's either open or selected in the message list.
To print a message
1 From the File menu, choose Print (CTRL+P).

The standard Windows Print dialog box is displayed, with the check box for printing 
multiple messages on a page selected. If you don't clear the box, the messages are 
printed continuously without page breaks between them.

2 Choose the OK button.
Note  Embedded objects are printed, but attached files are not. Attached files must be 
printed from the application used to create them.
See Also

Opening and Saving an Attachment
Saving a Message as a Text File



Reading a Message
Messages you receive are put in the Inbox, and the messages you haven't read are shown 
in bold.
To read a message in another folder, you must first open the folder to display the messages
in it.



Reading a Message

To read a message
Tip  To quickly display a message with the mouse, double-click its header.
1 If necessary, expand the folders list to display the folder with the message you want to 

read.
2 Open the folder.
3 From the message list, select the message you want to read.
4 Press ENTER, or from the File menu, choose Open (ALT, F, O).
5 If necessary, click the scroll bar or press the PAGE DOWN key to read the entire message.
6 To read other messages in the list, click the Previous or Next button, or from the View 

menu, choose Previous (ALT, V, P) or Next (ALT, V, N).
7 To close a message window, press ESC or CTRL+F4.

See Also
Deleting or Retrieving a Message
Moving Messages Between Folders
Replying to a Message
Saving a Message as a Text File



Replying to a Message
Many messages you receive require a reply. If a message has multiple recipients, you can 
reply just to the sender of the message or to everyone who received it.
When you reply to a message, the sender's name is entered in the To box, and the subject 
of the original message is entered in the Subject box, preceded by the prefix RE: (for 
Reply). Also, the contents of the original message are included in the message body.
When replying to a message, you can use all the features that are available when sending 
mail.



Replying to a Message

You can reply to a message that's open or selected in the message list.
To reply to a message
1 Address your message in one of two ways:
    To reply only to the sender, click the Reply button, or from the Mail menu, choose Reply 

(ALT, M, R).
    To reply to the sender and everyone in the To and Cc boxes, click the Reply All button, or 

from the Mail menu choose Reply To All (ALT, M, A).
2 Type your reply.
3 Click the Send button.
Note  The contents of the original message are included in the message body. You can add 
your own comments to the original, or you can delete the original contents.

See Also
Attaching a File
Forwarding a Message



Saving an Unsent Message 
There may be times when you are composing a message and are unable to complete it. You
can save the unfinished message and finish it later.



Saving an Unsent Message

To save an unsent message
1 Double-click the Send Note window's close box, or press CTRL+F4.

Mail asks if you want to save the changes to the message.
2 To close the window and save the message in your Inbox, choose Yes.

You can display the message later and finish composing it.
Note  Messages that you've saved before sending are indicated by the Open Message icon 
in the message list:

    Open Message icon
See Also

Creating and Using a Message Template
Sending a Message



Sending a Message
You can send a message to one or more Mail users. To address a message, either type the 
recipients' names in the address boxes of the Send Note form, or choose names from the 
address list. This procedure covers typing names. 
Each Mail user has a unique user name stored in the postoffice. You must use that name 
when addressing the message.



Sending a Message

To send a message
1 Click the Compose button, or from the Mail menu, choose Compose Note (ALT, M, N).
2 In the To box, type the user name of the recipient.

Separate multiple names with semicolons (;).
Tip    You can type the first few characters of a user's name and have Mail supply the rest 
of the name by pressing ALT+K.

3 If you want people to receive courtesy copies, press TAB or ALT+C to move the insertion 
point to the Cc box and type the user names. 

4 Press TAB or ALT+J to move the insertion point to the Subject box and type the subject.
The subject appears in the message list of the recipient's Inbox.

5 Press TAB to move the insertion point to the message body and type your message.
6 Choose the Send button (ALT+S).

A copy of the message is placed in the Sent Mail folder if you've chosen that option from 
the Options command on the Mail menu.

See Also
Attaching a File
Copying Information from a File
Using Mail's Address List



Setting Mail Options
With Mail's Options dialog box, you can choose options that are applied to every message 
you send or receive. You can also choose to empty the Deleted Mail folder when you quit 
Mail.



Setting Mail Options

To set Mail options
To display the Options dialog box, choose Options from the Mail menu (ALT, M, O).

To select options applied to messages you send
To keep a copy of every message you send in the Sent Mail folder, select the "Save 

copy of outgoing messages in Sent Mail folder" check box.
To add message recipients to your Personal Address Book, select the "Add recipients 

to Personal Address Book" check box.
To select options applied to messages you receive

In the "Check for new mail" box, type how often you want Mail to look for new 
messages in your inbox.

If you want Mail to notify you audibly when you receive a new message, select the 
"Sound chime" check box.

If you want Mail to briefly change the mouse pointer to an envelope icon when you 
receive a message, select the "Flash envelope" check box.
To empty the Deleted Mail folder when quitting Mail

Select the "Empty Deleted Mail Folder When Exiting" check box.
See Also

Setting Message Options
Working Offline



Signing In to or Out of Mail
To get access to your Mail messages and use the postoffice, you must first sign in to Mail 
using your password. The signing-in process prevents others from reading your mail or 
sending messages in your name. When you sign out of Mail, you are disconnected from the 
postoffice.
You may have other applications that require you to sign in to Mail, such as Schedule+. This
is because it uses your postoffice to communicate with the other members of your group. 
You can exit Mail but remain signed in to the postoffice so these other applications that use 
the postoffice can continue to work. If you sign out of Mail, these applications are closed.



Signing In to or Out of Mail

To sign in to Mail
1 From the Main group, double-click the Mail icon.
2 Type your mailbox name and password in the Sign In dialog box.

For security, you do not see the characters as you type them in the Password box.
To have Mail sign in automatically
1 Select the Mail icon in the Main group.
2 From the Program Manager File menu, choose Properties (ALT, F, P).
3 On the Command line, following the path statement for MSMAIL.EXE, type one space and 

then your mailbox name.
4 To have Mail automatically enter your mailbox name and password, after your mailbox 

name type one space and then your password.
To sign out of Mail

From the File menu, choose Exit and Sign Out (ALT, F, T).
If another application that uses the postoffice is running, such as Schedule+, this command
closes and signs you out of it as well.
To exit but not sign out of Mail

From the File menu, choose Exit (ALT, F, X).
If another application that uses the postoffice is running, such as Schedule+, this command
closes Mail but leaves you signed in to your mailbox.
If no other applications that use the postoffice are running, this command closes and signs 
you out of Mail.



Saving a Message as a Text File
When you want to use the text of a message with another application, such as a word 
processor, you can save the message as a text file.
Attached files are not saved with messages you save as text files; you must save attached 
files separately.
If you save a file under an existing filename, you can overwrite the existing file or append 
the new file to the existing file.



Saving a Message as a Text File

You can save a message that's open or selected in the message list.
To save a message as a text file
1 From the File menu, choose Save As (ALT, F, S).

In the Save As dialog box, the first eight characters of the message's subject are entered 
in the subject field, followed by the .TXT extension. Unless you type another extension, 
Mail adds .TXT to the filename to remind you that the file is a text file.

2 You can type a new filename in the File Name box, or change the drive or directory.
3 Choose the OK button.

If the filename you specified already exists, you are given the option of replacing the 
existing file with the new file(s) or appending the new file(s) to the existing file.

See Also
Opening and Saving an Attachment



Verifying User Names
You can type the first few characters of a user's name in the To or Cc box of a Send Note 
form. Mail fills in the rest of the name if it is valid when you choose the Send or Check 
Names button. 
If there are multiple names with these characters, you are presented with a list of the 
names to choose from.
Verified names are underlined and cannot be modified.



Verifying User Names

To verify a user name
1 In the To or Cc box, type part or all of the message recipient's name.
2 Choose the Check Names button or, if you are ready to send the message, choose the 

Send button.
If you have entered only the first part of a name, Mail fills in the rest of the name. If there 
are multiple names that contain these characters, you are presented with a list of names 
to choose from.

User names that have been verified appear underlined, and cannot be modified.

See Also
Updating Your Personal Address Book
Using Mail's Address List



Copying, Moving, or Deleting Information Within a Message
You can copy, move, or delete text and other information, such as graphics, in the message 
body. If you use the Cut or Copy command, the information is placed on the Windows 
Clipboard (a temporary storage area in the computer's memory). You can then paste the 
information at another location in the message.



Copying, Moving, or Deleting Information Within a Message

To copy, move, or delete information
1 Select the information.
2 Do one of the following:
    To copy the information to the Clipboard, press CTRL+C.
    To move the information to the Clipboard, press CTRL+X.
    To delete the information, press DEL.

To paste cut or copied text
1 Move the insertion point to the location in the message where you want the information.
2 From the Edit menu, choose Paste (ALT, E, P), or press CTRL+V.

See Also
Copying Information Between Messages 
Copying Information from a File



Working with an Embedded Object
If you include an embedded object in a message you're composing or you receive a 
message with an embedded object, you can modify the object in the message. Note that 
you must have the corresponding application.
Some objects, such as animations or sound recordings, must be activated for you to see or 
hear them. 



Working with an Embedded Object

To modify an object
1 In the message body, double-click the object, or select the object, and from the Edit 

menu, choose the Object command (ALT, E, O).
The application used to create the object opens with the object ready for editing.

2 Edit the object.
3 From the application's File menu, choose the Update command, or close the application.

The object in your Mail message is updated to reflect the changes.
To activate an object
1 In the message body, select the object as you would text.
2 From the Edit menu, choose Object (ALT, E, O).

The menu displays the commands available for working with that object.
3 Choose the command that activates the object.

See Also
Embedding an Object In a Message



Working Offline
You may want to compose or process messages while away from your office -- for example, 
while traveling or working at home. If you have Windows for Workgroups, Mail, and your 
message file installed on your computer, you can work with your messages without being 
connected to the postoffice. When you do, you are working "offline." Sent messages are 
saved in the Outbox until you connect to your postoffice.
When you connect to the postoffice after working offline, the messages in your Outbox are 
automatically sent.



Working Offline

The computer you will be working with offline must have Windows for Workgroups and Mail 
installed.
Before working offline, you must have your message file on the computer or disk you will be
working with offline. Your Personal Address Book is copied with the message file.
To work offline
1 Start Mail.

If the computer is not connected to your postoffice, a message appears asking if you 
want to work offline.

2 Choose the OK button.
A dialog box appears, asking for your password. 

3 Type your password, and choose the OK button.
4 If Mail cannot find your message file, you are requested to specify the path to it.
After you finish composing a message, choose the Send button. The message is moved to 
the Outbox. When you connect to your postoffice, the messages in your Outbox are 
automatically sent.

See Also
Saving an Unsent Message
Signing In to or Out of Mail



Expanding and Collapsing Folders
 If you create a lot of folders with many subfolders, the Folders list can become long and 
require a lot of scrolling to find a particular folder. You can hide, or "collapse," the entire 
Folders list and view just the folders at the first level. You can then "expand" all folders or 
an individual folder to show its subfolders.



Expanding and Collapsing Folders

To expand or collapse a folder
Click the plus sign beside the folder or subfolder to show its subfolders. Click 

the minus sign beside a folder or subfolder to hide its subfolders.
Press TAB to move the highlight to the folders list, use the arrow keys to move 

the highlight to the folder you want to expand or collapse, and press the PLUS SIGN or MINUS 
SIGN on the keyboard.
To expand or collapse all folders:

To show all folders, press CTRL+PLUS SIGN. To show only the first level of folders, press 
CTRL+MINUS SIGN.

See Also
Creating a Folder or Subfolder
Deleting a Folder
Moving a Folder Within a Folder
Moving Messages Between Folders



Click the first letter of the word you want to look up, or press TAB to select the letter and then press ENTER.
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